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Enhancements

Enhancements in Civil 2023 (v1.1)

1. Moving Load Analysis to French Former Standard: FASCICULE N° 61 TITRE Il
2. French National Annex to Eurocode 2, 3, 4

3. Eurocode Design Report in French

4. Eurocode Design Report in Word Format

5. Preference Setting for Design Report Language

6. Time Dependent Material: Modulus of Elasticity Suggested by Gilbert and Ranzi
7. PSC Design: User Input of Torsion Parameters, Ak and uk

8. Equivalent Beam Stress Results for Construction Stage Analysis

9. GSD Excel Report: Print Results of All Load Combinations

10. Concrete & Rebar Material Database to South Africa: TMH?7

11. Concurrent Disp./Vel./Accel. for Time History Analysis

12. Transmission Zone Design of Pretensioned Beam to AASHTO LRFD
13. SNiP/SP PSC Design: Crack Opening Coefficient by Tendon Material
14. Concurrent Joint Forces

15. Improvement in Auto Load combinations as per IRC 6
16. Improvement in PSC design parameters as per IRC 112:2020
17. Improvement in PSC & RC design as per IRC 112:2020

18. Other Enhancements




Civil 2023

1. Moving Load Analysis to French Former Standard: FASCICULE N° 61 TITRE Il

« Vehicle library has been added for former French national standard.

- Fascicule N° 61, Conception, Calcul et Epreuves des Ouvrages d'art, Titre Il - Programmes de Charges et Epreuves des Ponts-Routes (in French)

Civil 2023 (v1.1) Release Note

= Load> Moving Load > Moving Load Code > France
| Define Standard Vehicular Load * | Define Standard Vehicular Load *
Standard Name Standard Name
| Load System A ¥ | toad System B i
{  Vehicular Load Properties | Vehicular Load Properties
Vehicular Load Name : Load System A Vehicular Load Mame : Load System Bc
Vehicular Load Type : Load System A ~ Vehicular Load Type : Load System Bc ~
B Pz Pz B Pz Pz
A =alxa2x Al l l l l
v ¥ 5 P 5 I- — -I
f { ol Dz =4.5m it Dz
L
AL) = 2.3 = 360/(L+12) KN/ No  Load(d) Spacing(m) FesrmisiEmn i laEs
AL xal = (4-0.0020) kN/m 1 &0 a5 Min = 4.5m
2 120 15 Max = Infinite
3 120 end
Coeffidental
MNumber of Loaded Lanes 1 2 3 4 =5 Coefficent be
Bridge JEEE L L 0:IO°73 | O:1j Number of Loaded Lanes 1 2 3 4 =5
Second Class 1 0.9 - - - -
Class : First Class 12| 1.1[ 095 o8| o7
Third Class 0.9 0.8 = = = Bridge
Class Second Class 1 1 = = =
Lane Width Coeffident 82 = vOfv v = Loadable Width/Mumber of Lanes Third Class 1 0.8 - - -
Nominal Width {m) Vo a
Dynamic Factor
First Class 35 R
Eg::g: Second Class 3
Third Class 275 Cancd Epply
Load System Bc
oncel sosly
Load System A

| Define Standard Vehicular Load X
Standard Name
-
Vehicular Load Properties
Vehicular Load Name : System Mc 80
Vehicular Load Type : System Mc 80 ~
Tracked
Vehicles P P
TS S U S
! ] ! ]
I 0 i I D i
= 35.4m
Min. Distance Between Two Vehides 35.4 m
P 720 kn D SEE m
18 Apply Dynamic Factor
Concel sooly

Military Load Mc 80
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Civil 2023

Civil 2023 (v1.1) Release Note

1. Moving Load Analysis to French Former Standard: FASCICULE N° 61 TITRE Il

- Define the roadway width in the lane definition rather than the individual lane.

= Load> Moving Load > Moving Load Code > France

Lane Mame : Lane B

Traffic Lane Properties

2,25 4,50 1,50 |1225| 2,25 450 1,50 R25
4 )
AP N S - 5 5 5 5 0,20 0,25
T —a 60KN 120KN  [20KN 60KN 120KN  120KN| _.|_|.._ _.|_|‘_
Start End 10,50 . 10,50 . 3 % \
.. =) -
a ¢ Eccentricit L
Y Longitudinalement PR 8

2,00

© Load System (& or B)
() Military  Sidewalk / Pedestrian

Loadable Width 8.1 m

:

N\
N\
J0.50 |

Mumber of Lanes 2 _
Eccentricity a m ] =
77 T 7
0,25 2,00 ‘ 0,50 2,00 025 % %
' OO i ° . °
< > 4,50 | 1,50 |
i T il
T |oadable Width

Figure 4.1 : Systéme B.
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Civil 2023

1. Moving Load Analysis to French Former Standard: FASCICULE N° 61 TITRE Il

Civil 2023 (v1.1) Release Note

. . @ MIDAS/Text Editor - [MVmaxBcFz62_DetailResult] — O X
- Enterthe span length and span weight for each span to calculate the dynamic factor, 6. e _
@ File Edit View Window Help - & x
N N . DeEd&RBE B = . ¥ = 4 ab A |-p
+ The maximum weights of load system Bc for each span are determined by program. iy :1'
++ midas Civil F Mowing Load [ o |
booos  + mﬂ\liéé LéQé'Caéggc? Ninarge 0 —
- - 00004 * | t o i
= Load> Moving Load > Moving Load Code > France oooos ﬁﬁﬁponiﬂggl: I .
e asimum value . o, L3
00008
00009
D . = 00010 [Lanel ] |
L[] 00011
ynamic actor 00012 + Multiple Lane Fﬂctnrghc}, 1st Wehicle : 1.100
o 00013+ Multiple Lane Factor(bc), 2nd Wehicle @ 1.100
arfic Line Lane [} 4 [} ( gggl; + Oyramic Factor for Each Axle @ 1,241, 1,161, 1,181, 1,161, 1.161, 1,161
5 _ =l ] 2 00016
Lane Mame : Lane B - 7 s [LaneZ ]
' I + [}?EL (J 00018+ Multiple Lane Facturghc}, Ist Nehicle @ 1.100
. I _|_ 4 - 00020 + Multiple Lane Factar(bc), 2nd Yehicle @ 1,100
Traffic Lane Properties 00021 + Oynamic Factor for Each Axle : 1.241, 1,161, 1.161, 1.161, 1,161, 1.161
— S ooz
4 » |
3 f Ready tn0/21, 2
TR fa | L1 =24 m, G1=2362kN L2 =10 m, G2 = 1520 kN |
Start End |< >« :|
a = Eccentricity | | |
g g g5
© Load System (A or B)
() military / Sidewalk / Pedestrian
Loadable Width 8.1 i & i . B el
[ [+ ] [r=1] (=1 o
Number of Lanes 2 R S T A N A R Rl e I R R oo R R R sl ol
Eccentricity 0 m = = = 2 2 +
i —— T By ——ﬁ
8 Dynamic Factor for System B E? -— =T 1 —EI-——EI-——————--EI-———————E:-E-—————ga——rEL. ¢
L (Span Length) 24 m @
G (Span Weight) 2362 kM e — — = — e | B — - — W y:ﬁ L
[ centrifugal Force | | |
Left Wheel of Vehide 0.0 —
Moving Forward Eccen| L G | Span Eccen.| L G | Span
No|Elem = ™| iy | oo stant | NolBlem| =1 i | ey | Start
1] 82| -405| 24|2362| 40| 121 -4.05| 10f[9s0.| [
2l 22l _ansl 24l93R2] T

MibAS
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Civil 2023 (v1.1) Release Note

1. Moving Load Analysis to French Former Standard: FASCICULE N° 61 TITRE Il

- The effects of the centrifugal forces can be added to the effects of vertical loads.

Traffic Line Lanes

Lane Mame : Lane B

= Load> Moving Load > Moving Load Code > France

Traffic Lane Properties

s

Stl:art End

a = Eccentricity

© Load System (A or B)
() military / Sidewalk / Pedestrian

Loadable Width 8.1 i

Number of Lanes 2

Eccentricity 0 m
(") Dynamic Factor for System B

L (Span Length) 0.0 m

G (Span weight) 0.0 [}
B centrifugal Force

Left Wheel of Vehide 0.08

Moving Forward

The ratio for the increase of left wheel load to consider the centrifugal forces

7‘?“50 if R <400 —80
m .

6R %350 I R if R >2400m

N ok _

|
[ I T T !
[ — ] T —= 1 — |1 —
s = @ Z & &

Vertical Loads with Centrifugal Forces
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Civil 2023

2. French National Annex to Eurocode 2, 3, 4

«+ French national annexes have been added for Eurocode 2, 3, and 4.

Civil 2023 (v1.1) Release Note

= Design> RC Design, Steel Design, Composite Design

| Composite Steel Girder Design Parameters * 1
Code: EM1994-2 ~ MA: France ~
Partial Factor

Concrete(Gamma_C) P5C Design Parameters

Reinfording Steel{Gamma_5)

Design Code : -2 National Annex :
Structural Steel(Gamma_M0) . Eurocode2-2:05 >
Structural Steel(Gamma_M1) Input Parameters
Shear Resistance of a Headed Stud(c e
Moment resistance

Equivalent Constant Amplitude Stress

© Consider tendons in tensie zone (") Consider all tendons

Fatigue Strength(Gamma_Mf) A —

Fatigue Strength of Studs in Shear(G Strut angle

Stress in Structural Steel{Gamma_M,s 45 (Degree)

Damage equivalence factors(for Resis
Design life of the bridge in year(t_Ld) Prestressing steel type
© 5mooth bars and wires

O Indented wires

O strands
() Ribbed bars

Stress Limitation
ki: 0.6 k2:

Shear Resistance Reduction Factor of [T user input data Modify design parameters.

ks: 0.75 Output parameters
Ultimate Limit States R RERRS Serviceabilit
8 Bending Resistance [[] ultimate bending resistance [ stress
8 Resistance to Vertical Shear [Jshear resistance [Dstress
B Resistance to Lateral-torsional Bud () Torsional resistance [JPrincipa
B Resistance to Transverse force [ Principa
8 Resistance to Longitudinal Shear [ Tensile
B Resistance to Fatique (D cradkd

Composite Steel Girder Design

PSC> PSC Design

France ~

Serviceability limit state
Crack control
Cement dass

Steel Design Code

Design Code : Eurocode3-2:05

National Annex : France

(] all Beams/Girders are Laterally Braced

[T Check Beam/Column Deflection
Biaxial moments for buckling resistance

© Biaxial moments at the same location

() Maximum moments along the member

(] Consider as linear summation for dass 1,2

(Eq.6.2)
Method for interaction factor, kij
0 By Code () Annex A

Point of load application for Mcr
O Top © shear Center

Prestressed Girder Design

O Annex B

O Bottom

Close

Concrete Design Cede

Design Code : Eurocode2-2:05 ~

National Annex : France

Moment Resistance

Moment Redistribution Factor for Beam :

Column Design
10 Axial load plus biaxial bending(Fx +My-+Mz)
() Axial load plus biaxial bending{Fx+My)

(] Consider Axial-Moment Interaction for Plate Column

Shear Resistance

Strut Angle for Shear Resistance :

Yot brage : .

Norme

NF EN 1992-1-1/NA

5 E— =T

Mars 2016

P18-711-1/NA
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Civil 2023

3. Eurocode Design Report in French

- Design reports of Eurocode can now be generated in French.

Civil 2023 (v1.1) Release Note

= Design> RC Design, Steel Design, Composite Design
= PSC> PSC Design
MIDAS Information Technology Co.,Ltd.
Civil 2022 (v1.1) / Vérification
= NOM DU MEMBRE : Slab-BC
1. Informations de I'élément
1) Code de conception
EN 1992-2: 2005 [ NA:France }
2) Propriéte de section
10(I1D:10)
3) Propriété matérielle
fek = 30.000MPa, f, = 500.000MPa
4) Longueur
L=0.514m
5) Données de ferraillage
Bot-Dir.1: P16@300
Top-Dir.1: P16@300
Bot-Dir.2 : P12@300
Top-Dir.2 : P13@300
2. Capacité de Moment ( Dir-x, Négatif )
Memb No. 740
Neceud No. 777
Moment Nég. LCB cLCB2
Mezd / Mad -56.696kN-m/m / -55.070kN-m/m = 0.960 oK
Prin , P, Proax Pmin = 0.00151 < p = 0.00319 < pmax = 0.04000 oK

1) Paramétre de conception

*cLCB2 :( 1.330 )SW+( 1.300 JEHmax+( 1.350 )LS+ 1.350 )MVL1+ 1.350 JEV

fek = 30.000MPa, fix = 500.000MPa
bw = 1,000.000mm, h = 260.000mm

d =210.000mm

Ast = 670.200mm*
ctee = 1.000

ye = 1.500, y= = 1.150

fed = tec fuk /e = 20.000MPa

fya = fy /ys = 434.783MPa

00 =~ & s L P =

[T RN R T R T I T I I S R i T
| AWM= O wWw o0 =@M = OO0 = @ mMmE L= O

A|B|/C|D|E|F|G|H|I

J KILMNOPQRS TUVWXY ZAABACADAEAFAG

Cislo prvku

16

Position Information

J

1.Nastaveni posudku
1.1 Navrhové paramatry

- Diléi souginitele pro mezni stav Unosnosti (EM 1992-1-1:2004, 2.4.2 4)
Navrhové situace Yo beton Y= betonafska wyztuz Y= predpjata wztuZz
Trvalé & Docasné 1.500 1.150 1.150
Mimofadné 1.200 1.000 1.000
- soucinitel des ., @ - Soutinitel pro dlouhodobé G€inky dnosnosti vtlaku a tahu.
Oge = 0.850 (pro Unosnost betonu v tlaku)
Oy = 1.000 (pro unosnost betonu v tahu)
1.2 Prifezy
b 8500.0 mm ly 7.8668E+12 mm* A 0.000 mm?
h 3000.0 mm I 2 9574E+13 mm* A 0.000 mm?®
de 0.0 mm &, 42500 mm A 0.000 mm?
ds 0.0 mm & 1790.6 mm At 0.000 mm®
A 6208720.000 mm? P 0.000 mm?
1.3 Materialy
- Beton
fae = 40.000 MPa E. = 35220.000 MPa
- Wyztuz
fe = 400.000 MPa E. = 200000.000 MPa
1.4 Predpjaté kabely
i Ploch Pevnost (MPa|
Typ Nazev kabelu Pozice Ocza : : =)
(mm) (mm=) fox fon. 1% (MPa)
1|5_A2L 500.0 2635.300 1900.000 1600.000 200000.000
2 |5_A3L 700.0 2635.300 1900.000 1600.000 200000.000
3 |S_AdR 900.0 2635.300 1900.000 1600.000 200000.000
415 _AdL 900.0 2635.300 1900.000 1600.000 200000.000

MibAS

8/23



Civil 2023

4. Eurocode Design Report in Word Format

- Design reports of Eurocode are now generated in Word format, which is faster than Excel format and enables the user to change the report style with ease.

« PSC design report s still in Excel format in this version.

Civil 2023 (v1.1) Release Note

- o . . . .
Design> RC Design, Steel Design, Composite Design
H ©- (O = Test0323 %0.doc_Beam [Compatibility Mode..  DKOILiZ [ — O
[REIeY Insert | Desig | Layou | Refers | Mailir | Revie: | View | Help | Design | Layo | 7 = =
. - (3 = Tutl3-DSimple2-Bay Frame_St| [Compatibi.. DK OIL§2
3{; Arial -9 -
DE@ B I U -akex, X A
Paste . L. 01 Sagging class 1 or 2940Memb [Compatibility Mode] - Word ~ Ta.. DKOIGi2Z 0 - o
- ¥-A-ra- A A A AJ
Insert Design Layout References Mailings Review View Hel Design Layout  Q Tellme £ Share
Clipboard 1 Font ® Paragraph 0 B I U-aex x A gn ey g P g v i &
Paste o .. P A Styles  Editi
MIDAS Information Technology Co_Ltd - Y - .ﬂ. rAar A A A= T AT zl T - -
Civi B I U -abex, X* # i
5 n 7 P Past Styles  Editin
Clipboard Font F] Paragraph w Styles E,SE - aly A | KA E e ;l T t{es o g
= MEMBER NAME : 500x300 ( Section ID : 1, Element No.1)
MIDAS Information Technology Co.,Ltd Chhcandis) (Fentt (&) Earagaph) (e S B -~
Civil 2022 (v1.1)  Checking -
1. Member Information 7
1) Design Cade = MEMBER NAME : Column 7 W8x35 (1D : 1)
EN 1992-2: 2005 ( NA:Htaly )
1. Member Information o :
2) Section Property = MEMBER NAME : Steel Composite : 1 - j
R 1) Design Code
5004300 (101} ! :
EN 1853.2: 2006 { A Recommended | 1. Member Information
3) Material 1) Design Code
Cancrete 2) Material EN 1954-2 { NA : Recommended |
£, = 2500MPa £, = 31.475MPa f, = 1711.357MPa, E = 139,343024MPa 2) Section Property
Reinforcement 3) Length Comp
£, = 430MPs, f,,, = 430MPa, £, = 206000MPa | < 26s8m 3) Mas:eaglal
4) Length 2y partial factors f, = 345.000MPa, E. = 210,000.000MPa
L = &000m ! Conerete
Voo = 1000 Vhat = 1000 haz = 1280 f = 30.000MPa, E. = 33,000.000MPa
Reinforcement
5) Reinfor t Data .
) Resnforcemen 5) Saction Properties f.0 = 500.000MPa, £, = 200,000.000MPa
2 E z 4)Length
§] g g —— —1
I [ e ES L=1.000m
5| Partial factors
A " E Factor
H e for concrete 1.500
B . for reinforcing steel 1150
h - i for Structural steel 1000
] [ - [ —— Y for structural steel 1.100
' e o . yu for headed sutd 1.250
l&l 51 for equivalent constant Amplitude stress range. 1.000
Top P2 Top 2Pz Top T o e P T— — B otoonm Vo for fatigue strength 1000
Bottom  2-P24 Bottom  2-P24 Battom c, & | 103724mm k| sissenm Vit for fatigue strength of studs in shear 1000
Stimups  2-P14@200 Stimups  2-P14@200 Stimups :f-. :f-: e W | 263531 70man &) Section Properties
2. Moment Capacity ( Negative ) { Sector |, 0.25L ) ~
2. Check Axial Resistance + |l + g
Memb Ne. 1
Neg Lce Lcat ey sl ] )
Moment My £ M 0.000kN:m / 1368kN-m = 0.000 — 207283k / 2,325 GEEkN = 0124 oK
B Paw P =000155 < p = 0008ES < p,., = 004000 5
~oar 1) Check slendamess ratio of compressive membar L
KL
— = 70936 < 200000 —+ OK
Page1of4 348words [J8  English [United States) E B ! -
— [ [ Steel Section | _composite Section{ Positive) | Composite Section( Negative ) |
Page10f9  2471words [[#  English (United States) B B - 1] [ Area [ 34,687.500mm* | 155 867.676mm* 43,132.020mm? | -
; - s — u e e i
4 »
Page1of5 1515words [[Z  English {United States) B B - '] + 100%

MibAS
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Civil 2023

5. Preference Setting for Design Report Language
- The preferred language of the design reports can now be selected from the Preference for Eurocode and AASHTO LRFD.

« The preferred unit system of the design reports can now be selected from the Preference for AASHTO LRFD.

Civil 2023 (v1.1) Release Note

= Tools> Setting > Preferences > Design/Load Code

Preferences

= Environment

Steel Concrete IComposihel SOD ]

General PN

Wl RC PSC Rebar

_____ Propesty Design Code : Design Code : Material Code :
Load Eurocode2-2:05 v Eurocode2-2:05 v ENO4(RC) v

- Results National Annex : National Annex : Material DB :
| Des.ign/Load Code | Recommended v Recommended v Class C v
2:::;2 He Report Language: Report Language:
&1 Output Formats Engish V| || |Engsh Y

Formats - Dim. & Others Rating Code ; CZt.ECh
Formats - Forces France

- Formats - Loads Poland

@ Save Changes Upon OK Default Al Set Default [I] Cancel

Report Language of Preference
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Civil 2023

6. Time Dependent Material: Modulus of Elasticity Suggested by Gilbert and Ranzi

+ Time-dependent modulus of elasticity suggested by Gilbert and Ranzi has been added.

- Time-dependent behavior of concrete structures by Raymond lan Gilbert and Gianluca Ranzi, 2010

Civil 2023 (v1.1) Release Note

= Properties> Time Dependent Material > Comp. Strength > GILBERT AND RANZI

- Modulus of elasticity

Add/Modify Time Dependent Material (Comp. Strength) x
For i < 40 MPa:
Mame Scale Factor Graph Options
Concrete 1.0 [ %-axis log scale [ ¥-axis log scale
Type .
O code () User 50 EC = pls 0.043 fcmz (ln MPa)
Development of Strength 45
Code: GILBERT AND RAMZI ~ :2 L _'_'_‘__,__.--""""__-F'—
) fomt xexp[s><[1—(28jtean SD " ,’// For 40 < fcmz < 100 MPa:
Mean in-situ compressive strength of concrete (fomi) 25 /‘/
40 Mfmm2 20 / .
. o/ Ec=p"210.024 /fomi +0.12] (in MPa)
Cement Type(s) pi}
Ordinary Portland Cement :0.38 ~ 5 /
Weight Density 2400 kgfjm3 0 = s : 23 . . . .
E— v W e e 2 - Modulus of elasticity with time
Redraw Graph ] oK Cancel

0.5
Ec(t)= (es1=V20) T E(28)
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Civil 2023

7. PSC Design: User Input of Torsion Parameters, Ak and uk

- Area and perimeter for the torsion design can now be user-defined for the PSC-Value type, PSC-Composite type, and General-Composite type sections.

Civil 2023 (v1.1) Release Note

Properties> Section > Section Manager > Reinforcements

| Section Manager

Mode

Reinforcements

Target Section & Element

=& Section : 3
T 1:T1-2 1500
T 2:Super TEnd
X 3 Super T Mid

Copy Reinforcements to...

Super T End

Grid: 100 i Snap

|&: was.6, 78167 |

VIEW

X
Longitudinal Reinforcement  Shear Reinforcement |

|8 same Rebar Dats ati & j-end

1] o]

8 Sianenal Beinforcement:
Pitch 150 mm
Angle 90 [deg]
Aw 402.2 mm2

() steel Bar for Web
Fitch 0 i
Angle 90 [deq]
Ap a mrn®
Pe a M
Shear Reduction Fackor 1

B Torsional Reinforcement
Pitch 100 mm
Awt 2011 mm?
Alt 1963.6 mm2

B Endosing Stirrup

O Auto Calculation © User Input

Ak_centerline 1304467 mm2
uk_centerline 4320 mm
Ak_outside 1539582 mm2
uk_outside 5707 mm

Shear Reinforcement of Section Manager

[A] =z

- centre-line

- outer edge of effective cross-
section, circumference u,

- cover
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Civil 2023

8. Equivalent Beam Stress Results for Construction Stage Analysis

- Equivalent beam stresses including von-Mise stresses of the steel beam sections are now provided for the construction stage analysis.

Civil 2023 (v1.1) Release Note

Main Control Data

B auto Rotational DOF Constraint for Truss/Plane Stress/Solid Elements
B tuto Mormal Rotation Constraint for Plate Elements

Tension [ Compression Truss Element (Elastic Link / Inelastic Spring)

[
LI

Convergence Tolerance 0.001

Mumber of Iterations/Load Case

[ Consider Section Stiffness Scale Factor for Stress Calculation

Consider Reinforcement for Section Stiffness Calculation

B change Local Axis of Tapered Section for Force fstress Calculation

(o
Main C | Data

React.. Defor.

[l Stres.

X

= Results> Stresses > Beam Stresses (Equivalent) or Beam Stresses Diagram (Equivalent)

|Eeam Stresses(Equivalent)

Load Cases

CS: Summation

Step Last Step hd
Stresses
() Mormal © von-Mises
(O Tau_xy () Max-Shear
(O Tau_xz () Princ. (maz)
() Princ. {min)
Position
() Maximum
O1(y,+)
O2(+y,42)
O3+, sjlis
Oatv,2 Y
OsMAy |4 7 3
Os A+
O701A2)
e NA42)
Type of Display
B contour [Ipeform
[ values B Legend
[l Animate [T Undeformed
[CIMirrored
Qutput Section Location
I Center J
Max All
Close

Hilcs

2
i

¢ o
S
i W iy
.,
< ~

Mises Stresses at Ce id of Steel Beam

MIDAS/Civil
POST-FROCESSOR

BEAM STRESS (EQUIV.)

Von-Mises

3

42925e+00
©629%5e+00
89666e+00
13036e+00
36407e+00
559777e+00
33143e+00
06518e+00
2988%9e+00
5325%e+00
66295e-01
.00000=+00

L R R - -

STAGE:CS

C5: SUMMATION

LAST

MEX : €080

MIN : 3000

FILE: 3D MODEL_~

UNIT: W/mm:

DATE: 04/15/2023
VIEW-DIRECTION

497
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Civil 2023

9. GSD Excel Report: Print Results of All Load Combinations

+ The design results for all the load combinations are now generated together in the GSD report.

Civil 2023 (v1.1) Release Note

= Tools> Generator > General Section Designer

Define Load Combination X
P P My Mz Vy Vz T

5| RemEmr i | e (kNxm) | (khxm) | (kN) | (kN) | (kNxm)

¥ [ [icot 000 2880.00 000] o000[ 000 0.00
2icb2 1000000  1550.00 000] o000 000 0.00

3|icb3 500000 1350.00] 112000) 000 o0.00 0.00

4|icos 754000 -241500] 2640.00| 0.00| 0.00 0.00

5icbs 359000) -1450.00] 3400.00) 000 0.00 0.00

Section View : Section1

Interaction Curve | Stress Contour

PM  My-Mz
Mode

O ange:
Checking Ratio
QKeepMP c

D

0.000000 Dea. OPy

onstant

Opz

(O Keep M constant

O Load Combinatien :

(O keep P constant

lcb1 ~

Hoop Type

Tie

Code : Eurocode2:04

Spiral

0

5
)

uy Mz
(khbcm)

18518.363|

0.000

NavaoD

13854.348|

2844.185

13259.834|

3088.594

12571.983]

3306.460

12091.494)

3500.334

11519.308|

3670.993

10856.736|

3820.881

10405547

3949.762

9865.821

4061678

9350626

4156.444

8858537

4235.074

8407673

4299.343

805,867

4343774

7645245

4321414

7113378

4271786

6522025

4185.485

4059.685

3889.404

3670.613

Mt

3399.924

3074.359

2690.837

o0
1350

1o00

260

o
000

2245.082

a0
o0

1558325

-1707.374

0.000

Report Al

Report

P-M Curve
Mode Load Combination = Icb1
Checking Ratio = 2.384 (Keep M/P Constant,
sooo P Pu(kN) Mn(kNxm)
{Thata=0.300s 18618363 0.000
17750 ; b 13854 348 2844 18
15500 P-M Curve
Mode Load Combination = lcb2
11000 Checking Ratio = 0677 (Keep M/P Constant
o S Pu(kN) Mn(kNxm}) -1
Thefazo.g00 6. 18618.363 0.000
6500 17750 P e 13854.348 2844.186
w250 vs2ho 13259834 3088.594
iayhaloha TREFT 65 S3RE AR
2000 13250 P-M Curve
B 1opo Mode Load Combination = Icb3
2500fgtenben b s 3750 Checking Ratio = 1.198 (Keep M/P Constant)
2 2 8 £ § aha 20000 F0EN) - Pu(kN) Min(kNxm)
L tams gene 18618 363 0.000
4250 7750 R Rst=i 18 15710483 1047858
. 15800 i 14919 966 1155330
2ape 14103774 1532567
£ Tegee 13293.674 1314.875
| 11000 41940C O9E 4204 £NC
L =T P-M Curve
2 8 8 750
prom Mode Load Combination = Icb4
Checking Ratio = 3.386 (Keep M/P Constant
4250 20005 FL(KM) . Pu(kN) Mn(kNxm)
2000 ML 1aDa 18618.363 0.000
i Rt 80 15473694 978839
1 i 15500 14670.065 1069.599
2380 13888355 1148447
88 13750 TR ATT 558 AGE
P-M Curve
11000 il
sTDU [ Mode Load Combination = Icb8
P BB Checking Ratio = 6.686 (Keep M/P Constant
20000 [2 1) - Pu(kN) Mn(kNxm)
€280+ NALS3 4204 18618.363 0.000
sonol 177 RaiS 10 14822 449 841783
15500 14056 620 5357683
13379.895 1019.282
12682.163 1086.550
11000 11979889 1145635
e 112887743 11547257
i } 10613.982 1232.493
o500 9967.001 1263.977
o 9331 757 1284.925
{2550, 2008) 8738 584 1258148
2000 8175284 1305.567
0. 784) M (kN 7738.030 1308.730
: : 7196163 1295125
250054 6466552 1270877
= = ™ Y
¢ B 8 B 8|9 B § § 8 5658242 1235.319
4791.853 1187.060
3908743 1107.766
2583810 1013575
2006.083 915.062
1018.217 766.886
-16.058 634672
“BEG B2 465838
-1564 498 89 669
1707374 0.000

MibAS
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10. Concrete & Rebar Material Database to South Africa: TMH7

- Concrete and rebar material database have been added for South Africa TMH7.

Civil 2023 (v1.1) Release Note

= Properties> Material > Concrete > TMH7

Modify Concrete Materials x
Material List
i) Name felfik|R Chk Lambda  Main-bar Sub-bar
1 Grade 40 40 X 1
Concrete Material Selection
Code : TMH7(RC) v Grade:  Grade 40 ~
Specified Compressive Strength (fc|fdc) ¢4 Njmm?2
Light Weight Concrete Facter (Lambda) ; -
Rebar Selection
Code : TMH7(RC) ol
Grade of Main Rebar : 450 Njmm3
Grade of Sub-Rebar : ik N/mm?
Madify Clase

Material Data
General
e Material ID 2 Name Grade %0
Elasticity Data
TypeofDesgn  Concrete v Sheel
Standard
D8
Type of Material
© Isotropic Orthotropic
Steel
Modulus of Elasticity : 0.0000e +00
Poisson’s Ratio 1 0
Thermal Coefficent : 0.0000e +00
Weight Density : 0
Use Mass Density: 0 Nfmm3/g
~Elconaete
Modulus of Elasticity : 3.10008+04  Nfmm2
Poisson's Rato  : 0.2
Thermal Coefficent : 1.2000e-05  y/ic)
Weight Density : 23605 Njmmd
() Use Mass Density: 234509 Njmmijg
Plasticity Data
Plastic Material Name NONE v

Inelastic Material Properties for Fiber Model

Concrete None v Rebar  None
Thermal Transfer
Spedific Heat 0 BtuN-[C]
Heat Conduction o Btu/mm-he[C]
Damping Ratio 0.05
(o« ] come

Apply

Concrete Material

Reinforcement Material

Rebar Material Property

Rebar Material Code TMHZ{RC)

Rebar Grade Type C

Rebar fy 450 M/mmz2
Modulus of Elasticity 200000 Mjmm?

Park Strain Hardening A4

Cloge

Stress Strain Curve

Reinforcement Material

Material Data

General
Material ID 2 Name Grade 40
Elastiaty Data
: A Steel
'ype of Desian RC v s d
D8
Concrete

Type of Material
© 1sotropic
Steel
Strenath 5
Modulus of Elasticity :
Poisson's Ratio
Thermal Coeffident :
Weight Density
Use Mass Density:

Concrete

Strength %
Modulus of Elasticty :
Poisson's Ratio
Thermal Coeffident :
Weight Density

(O Use Mass Density:

Orthotropic

0
0.0000e+00
0
0.0000e+00
0

0

40 Njmm2
3.1000e+09 Nfmm2
0.2
1.2000e-05 1M
23205 Njmm?
234509 NjmmoJa

C& ) ome

Apply

Concrete Material
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11. Concurrent Disp./Vel./Accel. for Time History Analysis

- Concurrent displacements of multiple nodes at the same time step are now available for the linear/nonlinear time history analysis.

Civil 2023 (v1.1) Release Note

= load> Load Type > Dynamic Loads > Time History Analysis Data > Define Concurrent Result Groups

= Results> Result Tables > Time History Analysis > Displ./Vel./Accel. (Concurrent)

Civil 2023 - [Untitled] - [MIDAS/Civil]

Ef O E e H S

Structure Properties

(&) Dynamic Loads () settlement/Misc.

(") Temp./Prestress () Construction Stage () Load Tables

View Node/Element Boundary Analysis Results Pushover Design Rating Query Tools

2y v T =
RS RS Load Global Load Time History Ground Dynamic  Time Varying Multiple Support Define Resu

Functions Cases Control - Cases Functions Acceleration Modal Loads Static Loads Excitation Functions
Response Spectrum Data

() static Loads

(i) Moving Load (i) Heat of Hydration

| Time History Analysis Data _ 4‘ T . ’
Time History Concurrent Result G~ lﬂ Concurrent{Max/Min) Reaction (‘:) o
* Concurrent(Max/Min) Joint Force /
Group Mame G1 ‘l' Displacements. f-'!
Mater Node 72 Tuss 7
Cable »
Sub Modes 7073 Beam »
Plate >
el =l Plane Stress 3
Ooisp.  Ovel. O accel. Plane Strain >
Axisymmetric » &max=8rmax-(6fp+efp~h+8s) &max=6rmax-(6fp+efp=h)
Component oY b Solid »
By Elastic Link

Mame Master Node Type i: General Link DX oY DZ RX RY RZ

B = Disgl. B; Resultant Forces toad Hhde (mm) (mm) (mm) (frad]) (frad]) (frad])

G2 1 Displ. $ Vibration Mode Shape Mater Node(72) 57.009500 0.000547 -0.205912 -0.000000 0.001634 -0.000033
* Buckling Mode Shape EX(max) Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
2B Effective Span Length Sub Node(73) 24129700)  -0.000193|  -0.077511 0.000001 0.001782|  -0.000050
I Mater Node(72) -77.853400 -0.003365 0.440000 0.000013 -0.001365 0.00001%
— G1 EX{min} Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000

Inelastic Hinge » Sub Node(73) -23.230400 0.000922 0.17005% -0.000003 -0.001508 0.000049

Operations Time History Analysis I » Displ/Velfaccel Mater Node(1) 131.728000 -0.012116 -0.319860 0.000002 0.000950 -0.000054

Add Modify Delete T N T — o EX(max) Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
e Sub Node(72) 55.605000 0.000733 -0.228289 -0.000001 0.001892 -0.000032

Close Tendon " Sub Node(73) 24.106900 0.000252 0.086362 0.000001 0.001773 0.000049

ComposRE St TarC » [l T Foree Mater Node(1) | -112.312000|  -1.110280 0.590966 0.000043|  -0.001041 0.000030

Define Node Groups ' ::"“::::::::' e » |BY Generatunk o Ex(min) Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
— Sub Node(72) -77.818700 -0.003272 0.432113 0.000013 -0.001381 0.00001%

28 |nitial Element Force Sub Node(73) -22. 805700 0.000893 0.167061 -0.000003 -0.001455 0.000045

Concurrent Displacements of Multiple Nodes
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12. Transmission Zone Design of Pretensioned Beam to AASHTO LRFD

- Pretensioned beam design is performed considering stress developmentin tendons as a bi-linear relationship defined by the transmission length and development length .
+ Flexuralresistance at ULS within development length is now calculated considering the development length.

Civil 2023 (v1.1) Release Note

PSC > Design Parameter> AASHTO LRFD

A/B/CDEFGHI JKLMNOPQRS T UV WX Y, ZAAABACADAEAFAG

Development Length in Report

141

142|2.Flexure design for a section

143: B Moment Direction Paositive

144? - Method of Calculation : Code

145_ - The maximum strength limit load combination : cLCB3

1462 - The maximum factored moment (M) : 6832.570  (kips-in)

147

148_ 1) Depth of neutral axis to compression face (See 5.6.3.1)

149: e Axial force in tendons(Bond) by Code

150 Tendon Name k Tz T=Al Af=(dc)

151 1 S_Spani-263 0.374 44509 9,658 541.010
152 2 S_Spani-253 0.374 44510 9,650 541.027
153| 3 S_Span1-243 0.374 44204

154 i & Bpani2aa s 13850 Tendon stress at ULS within development length
199|

200 5 Development Len |
201 Tendon name I (in) I (i) fe (ksi)

202 1 S_Spani-263 31.50 152.65 1575 4451
203 2 S_Spani-253 3150 152.65 15.75 4451
204 3 S_Spani-242 3150 153.15

205 i & EpanIsEa 35 je3sel” Transfer Length & Development Length
206

20]’: *The section is located within the transfer length

111100

ST
ﬁmﬂIIHHIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

Flexural Resistance Diagram

T
IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIh‘HIIHFIh;A

011000

Sfrand
Sfress

opu

op.ef]

Transmissiﬂn(L%t)
Developement Length (Lp)

At nominal resistance of member

L.,=60db

Ly = 0.145( 6u—0.67 G oe)dly = 604y,

Lpt

Lp

Stresses in the Tendon at ULS

1

11100

MIDAS/Civil

POST-PROCESSOR

BSC DESIGN
Flexure-y

2003,
1524.
1643.
1440.
1273.
10%5.
913.
730.
547.
365.
1s2.
PostCs 0.
ALL COMBINATICH

[ A T T e R )

MibAS
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13. SNiP/SP PSC Design: Crack Opening Coefficient by Tendon Material

- Crack opening coefficients for different tendon materials have been added for SNiP/SP PSC Design.

Civil 2023 (v1.1) Release Note

PSC> Design Parameter > SP 35.13330.2011

P5C Design Parameters

Design Code : SP 35.13330.2011 e
Input Parameter
Bridge Type Roadway /Pedestrian ~

8 operation Condition Factor (mb7, mbs)
© Ambient temperature for the coldest five days below -40C without concrete saturation
O Ambient temperature for the coldest five days -40C and higher with concrete saturation
O Ambient temperature for the coldest five days below -40C with concrete saturation
() User Defined 0.9 0.9

8 Operation Condition Factor (mbs)
© Not protected solar radiation in Climatic Zone IV A

() User Defined 0.85
Qutput Parameter
First Group Limiting States {ULS) Second Group Limiting States (SLS)
8 Ultimate Bending Resistance B stress for Cross Section at a Construction Stage

8 shear Resistance B Stress for Cross Section at Service Loads

8 Torsion Resistance B Principal Stress at a Construction Stage
B Faticue B Principal Stress at Service Loads
B Tensie Stress for Prestressing Steel

B ik Conl

PSC Design Parameters

Cancel

Material (GOST-SP) Crack Opening Coefficient, W
A600 1,5sqrt(Rr)
A800 1,5sqrt(Rr)

AT600 1,5sqgrt(Rr)
AT800 1,5sqgrt(Rr)
AT1000 1,5sqrt(Rr)

V1500 0,35(Rr)
V1400 0,35(Rr)
V1400 (Group S) 0,35(Rr)
V1400 (Group Zh) 0,35(Rr)
V1300 0,35(Rr)
V1200 0,35(Rr)

Vp1500 1,5sqrt(Rr)
Vp1400 1,5sqgrt(Rr)
Vp1200 1,5sqgrt(Rr)
K7-1500 1,5sqrt(Rr)
K7-1400 1,5sqgrt(Rr)

Crack Opening Coefficients

MibAS
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14. Concurrent Joint Forces

« Concurrent forces of the elements intersecting at a Joint are provided for the moving load analysis, settlement analysis, and load combinations.

« Inthis release, only Eurocode is supported.

= Load> Moving Load Analysis Data > Concurrent Joint Force Group

= Results> Result Tables > Concurrent (Max/Min) Joint Force

S Wi

— LC /&7 Plate Element for Influ, Surface "l..ﬂ Railway Dynamic Factor
E %1 Concurrent Reaction Group

Traffic Line | Traffic Surface Vehicles Moving
%: Concurrent Joint Force Group

Lanes ~ Load Case
Moving Load Analysis Lata

Moving Load Code

EUROCODE M

/1

\%%

_=:

‘L__ s

N
/Y,
-

(
/”/\
é/\,i/

i
i
AN

| 7

Tables Works Report
Group
=- ﬂ Structure Group : 2
i Cross Beam 1[ Node=0 ; Bement=22]

T Elem 301 an _
Elem Load Fx Fy Fz x My Mz Fx Fy Fz 1x Crzaii [lnie=t Earr =l
= Cogposent (e (ly (e (tl-m) (tl-m) (tl-m) (i ) ) (ktl-m) e Boundary Group : 0
11 |Noders “Apply -4, Load Group : 0
Results Fx 0.0 0.0 00 00 00 00 0.0 00 00 0.0 -4 Tendon Group : 0
Tables = Fy 5967 103 24 93 12 872 -538.0 148 =X 378
Fz ETIEE =7 285 51 800 397 131 54 216 53
£ p F ) [ T670 36 =5 64 710 708 473 74 140 214 o0
t eadtion W 12825 T4 EIE) 78 2077 e8| 11192 84 329 -1g,
. . Mz -1282.0 13 128 124 2117 ss2| 11305 128 251 214 i
B ConcurrentiMax/Min) Reaction = 2 E Z = i =2 = 125 = Tl Select Nodes and Assign Structure Group
Fy a7 EIK] 31 T4 492 XA 130 194 =2 613
% ConcurrentiMax/Min) Joint Force p U Fz -1084.8 7 148 9.1 7732 646 B 87 3286 -18.0 2858
4 RIGEY Mix 7878 98 [X) 107 -139 18 7135 -138 X 402 02
Displacements iy 12518 I3 178 79 2974 609 11085 82 342 121 303.1
Ld iz 11016 12 134 21 508 %36 o773 130 203 243 1640
Fx 19674 5.1 221 50 2142 511 17610 64 213 03 2141
Fy -1186.4 T4 136 75 2192 619  -10818 88 258 128 2205
. T Fz s782 539 92 159 7.0 57.4 71 53 ni 211 57.0
i 12965 EIK] 133 137 2130 27| 102 123 £ 28 228
iy E 35 56 64 720 X 449 73 141 214 571
Mz 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Fx -10182 15 18 64 20 -13:8 810 X =3 88 51
Fy 14615 107 187 129 2007 89| 12905 116 29 82 2085
Fz 5701 73 92 6.0 %3 610 5652 60 119 218 557
" Lt Ai(max) i 5448 23 104 129 37.0 359 432 23 58 EEX] 83
My 8880 T4 93 16.0 2 1.1 s83.4 80 19 219 555
Mz 12990 110 135 137 2110 w21 11430 121 250 22 2209
Fx 00 00 o0 00 00 ) 00 o0 o0 00 o0
Fy 14742 EX] 185 [ 2773 625 13155 B85 265 78 2779
Fz 14200 75 187 77 2914 629| 12813 84 313 104 2059
=L iRETY Mix S0z 45 30 114 920 B8 S096 24 18 X 21
iy 00 00 00 00 00 00 00 00 00 00 00
iz 00 00 00 00 00 00 00 00 00 00 00

Concurrent Forces of Members Connected at Joints
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Civil 2023 (v1.1) Release Note

15. Improvement in Auto Load combinations as per IRC 6

 Improvementin Auto Load combinations of Temperature load factors (Temperature uniform and Temperature gradient loads).

+ Updates in load factors for combinations considered for Special Vehicle as per IRC 6:2017 Amendments.

= Results > Load Combinations > Auto Generation

7.9.5 Partial factors for prestressing force

Load Combinations (1) Prestress in most situations, is intended to be favourable. However. under some load
combinations the effect may become unfavourable.

General | Steel Design Concrete Design | SRC Design | Composite Steel Girder Design | (2) Incase of bonded tendons. for nltimate limit state of strength. the design value of prestressing
@ el L e ek force shall be based on the mean value acting at that time, with partial factor y =1.
= Automatic Generation of Load Combinations oo s
No | Name | Active Type E ] ]
* r Option
® add O Replace 51
Code Selection
Steel @ Concrete SRC Steel Composite
Diesign Code : IRC:5 LSD ~
Manipulation of Construction Stage Load Case IRC:112-2020
O sTonly O cs only ®sT4C5 (3) In case of unbonded tendons and external tendons, the stress increase in ultimate limit state
ST : Static Load Case €5 : Construction Stage of strength may be calculated taking into account the overall deformation of the member.
Leading Variables If no such calculations are made, the increase in stress in prestressing tendon shall be taken
as nil. and partial factor y =1.
seiectl W1 : L/unbs d’; d d fi | bil d where d f
4 Where external/unbonded tendons are used for achieving stability and where decrease o
Wind Loads Thermal Act. Snow Loads ( ) = ty

force or increase of force becomes unfavourable for stability. partial factors of 0.8 and 1.25

o i . .
M Construction Loads shall be used to decrease or increase the force. as required.

| Traffic Loads Naote: These factors account for the possible adverse variation in prestressing force. This shall be over and above

; [(Jroad Traffic e the overall safety factors against overturming and shding required for global stability checks.

| [IMoving Load Case for Spedal Vehide (5) | In verification of local effects y . =1.3 shall be used

; I [use IRC112:2020 C1.7.9.5 I (6) In serviceability limit state, two characteristic values of prestressing force shall be used.

I < l P ko ]’;@_P ..._(‘E) (x) Eq. 7.7
| Cancel Prig = Vg T (U (X) Eq.7.8

ol Where

P (i)x) is effective prestressing force at point ‘x” at time ‘" and P, and P

Copy Import... I Auto Generation. .. I Spread Sheet Form i
o ATE corresponding

File Name: G:\OFC\testing\SV\RCC T girder_SV.lep | Trres Make Lo superior and inferior characteristic values. The values of Veup and Vot shall be as follows:

. - for pre-tensioning or unbonded tendons Vog =1.05and vy, o’ 0.95.

- for post-tensioning with bonded tendons ¥, =110 and y o= 0-9-
Auto Generation of Load Combination
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16. Improvement in PSC design parameters as per IRC 112:2020

- Addition of beta value for interface shear design for PSC Composite Girder design

Civil 2023 (v1.1) Release Note

= PSC > Parameters

PSC Design Parameters

Design Code : IRC:112-2020

Input Parameters
Ultimate limit states
Moment resistance

Shear resistance
Strut angle

oo

Prestressing steel type
® smoath bars and wires
O Indented wires

(®) Consider tendons in tensile zone

Serviceability limit state
Crack control
(") Consider all tendons Cement dass

Class R (s=0.20)

Beta (Interface shear)

[ User input data [

® 10 (") Exact design
O strands
O Ribbed bars
Modify design parameters... i

QOutput parameters
Ultimate limit states

[Jultimate bending resistance
[Ishear resistance

[J1orsional resistance

Serviceability limit states
D Stress for cross section at a construction stage
[ 5tress for cross section at service loads
|:| Principal stress at a construction stage
[ rrincipal stress at service loads
[ Tensile stress for prestressing steel
[ cradk contral

Auto Generation of Load Combination

Cancel

10.3.4 Interface Shear

The shear stress that arises between the interfaces of concrete placed at different times is referred to as
interface shear.

Precast beam with cast-in-situ slab is one of the typical case where interface shear has to be designed
for.

The interface shear is resisted by friction at the interface and by reinforcement placed across the shear
plane.

The interface shear stress should satisfy the following:

Veu SVan

where

Veu is the interface shear stress
Ve =BV, /Zh

|ﬂ is the ratio of the longitudinal force in the new concrete and the total longitudinal force.l

v, is the transverse shear force.

z is the lever arm and

b, is the width of the interface

Veu is the resisting capacity at the section.

VRdi = 1Oy + P frd [‘In'"ii_ﬂﬂf+COSlZ]S 0.5vfeq Eq.10.21
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17. Improvement in PSC & RC design as per IRC 112:2020
- RCdesign reports are now generated with reference to IRC 112:2020.

« Similarly, PSC reports are now generated with reference to the latest standard IRC 112:2020

Civil 2023 (v1.1) Release Note

= PSC > Excel Report
= Design > RC Design > Design Code

IRC:112-2020 v

Apply Spedal Provisions for Seismic Design

Moment Redistribution Factor for Beam @

Strut Angle for Shear Resistance @ Deg

ye

NS

o
[N

(5.1
>

o
A
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18. Other Enhancements

Civil 2023 (v1.1) Release Note

Update Interface with BIM software
- Revit 2023 Interface
- and Tekla 2022 Interface

Design based on concurrent member forces due to moving load analysis, settlement analysis and envelope-type
load combination.

- EC2 Concrete Design

- EC3 Steel Design

Option for Hambly equation or mesh to calculate the torsional constant of the composite section
- Check on: Calculate the torsional constant using Hambly equation for beam-and-slab decks. Same value
as previous version.
- Check off: Calculate the torsional constant from the mesh of the cross-section.

Properties>Section>Composite

[]Use Hambly Eq. for lxx

MibAS
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